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Launching ArcCatalog and ArcGIS, making a new ArcMap 
 

Launching ArcCatalog 

• Go to Start and click on All Programs. Click ArcGIS. 

• Double click on ArcCatalog to open. ArcCatalog is the electronic filing cabinet 

that organizes all of the data that you will manipulate in ArcGIS.  

• The Table of Contents (TOC) in the left hand part of the window show you the 

organization of folders and files and allows you to copy, paste, rename, and 

remove files (see sections below). 

• You can Preview a file by clicking on the Preview tab in the right hand window. 

Make sure that the pulldown menu at the bottom is set to Geography. In the 

Preview window, you will see a preview of what the file looks like, although you 

won't be able to do anything with it. 

 

Where to Save Your Maps and Files 
• You should create a folder dedicated to your current project for your data and 

maps. In other words, when prompted to save something, it should go into a 

folder for that project so that files aren't scattered or mixed in with those from 

other projects. 

• The crucial thing about folder and file names is that you must be absolutely 

certain that there are NO SPACES in folder or file names and no oddball 

characters. If you want a space in your folder or file name, you must put in an 

underscore. MAC USERS BEWARE. Spaces are OK in Mac file and folder 

names. They are not OK in ArcGIS. If you have trouble getting something to 

work in ArcGIS, the very first troubleshooting thing you should do is check all 

of your file/folder names to make sure that they have no spaces and no long 

names. 

• In Windows Explorer, the default location for saving files is a folder titled 

Documents and Settings, which, unfortunately, has spaces in the name. Even if 

you are careful to eliminate spaces in your file names, saving to the default 

folder means that you are dead in the water. That's why it's important to set up 

new folders that are not in the Documents and Settings folder and that have no 

spaces in the names into which you can save your files.  

• And, don't make a folder on the Desktop – ArcGIS does not like folders or 

files on the desktop. 

• When you create a new file based on an existing file, ArcGIS commonly 

suggests a file name. Unfortunately, this name can be too long and too complex 

(such as DEM_to_raster_0479343.tif). If you find that things aren't working, 

check to make sure that the file name is short and with no spaces. 
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Making a new ArcMap 
• Launch ArcMap, and select A new empty map.  

• Saving Relative Pathways in ArcMap. Before saving an ArcMap .mxd file to 
your folder, make sure that you will be saving relative, rather than absolute, 
path names. Go to File, Document Properties, Data Source Options, and click 
"Store relative path names" before saving your file. 

• Name and save your new file. The crucial thing about folder and file names is 

that you must be absolutely certain that there are NO SPACES in folder or 

file names and no oddball characters. If you want a space in your folder or 

file name, you must put in an underscore. MAC USERS BEWARE. Spaces are 

OK in Mac file and folder names. They are not OK in ArcGIS. If you have 

trouble getting something to work in ArcGIS, the very first troubleshooting 

thing you should do is check all of your file/folder names to make sure that 

they have no spaces and no long names. 

• In Windows Explorer, the default location for saving files is a folder titled 

Documents and Settings, which, unfortunately, has spaces in the name. Even if 

you are careful to eliminate spaces in your file names, saving to the default 

folder means that you are dead in the water. That's why it's important to set up 

new folders that are not in the Documents and Settings folder and that have no 

spaces in the names into which you can save your files.  

• And, don't make a folder on the Desktop – ArcGIS does not like folders or 

files on the desktop. 

 

Adding Spatial Analyst and 3D Analyst Extensions 
• If you intend to do hillshades, area and volume calculations, and so on, the 

Spatial Analyst and 3D Analyst extensions must be added. 

• If you find items such as hillshade grayed out, you probably have not added 

these extensions. 

• If you have tried to do an analysis and ArcMap tells you that you don't have a 

license for that operation, you probably have not added these extensions. 

• Go to the Tools menu, and select Extensions. 3D Analyst and Spatial Analyst 

must be turned on. If the two boxes are not checked, check them both. If they 

are checked, leave them checked. Click Close. 

• You can then go to View,  Toolbars, and click these two extensions to bring up 

the toolbars. You can then dock each toolbar by dragging it to the gray bar 

above the main window, or you can leave the toolbar floating. 

 

Managing the Windows – mostly for Mac Users!! 
• Clicking the red X box at the upper right of the active window quits the 

program. Mac users have to remember that clicking this box closes the window 

and quits the program, unlike closing a window on a Mac. 
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• Clicking the middle box lets you toggle between a full frame view of the window 

(which can't be moved around), and a view that shows more than one window 

and in which windows can be moved around. 

• Clicking the box with the minus sign closes the window without quitting the 

program. The window can be opened up again by clicking the name at the 

bottom of the screen. 
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Using the Academic Software Server with ArcGIS 
 
 
To view folders and files in ArcCatalog 
 

• Launch ArcCatalog. Click the Connect to Folder icon (the folder with the right-
pointing arrow over it). 

• In the dialog box that comes up, replace the words My Computer with 
\\software\academic\geology\. Be sure to use back slashes, rather than 
forward slashes. Click OK. 

• In the ArcCatalog Table of Contents column at left, expand 
\\software\academic\geology, and expand your course folder. 

• Locate your files by expanding either your own folder or your course Data folder. 
 
To add data in ArcMap 
 

• Launch ArcMap. Click the Add Data button. Click the Connect to Folder icon 
(the folder with the right-pointing arrow over it). 

• In the dialog box that comes up, replace the words My Computer with 
\\software\academic\geology\. Be sure to use back slashes, rather than 
forward slashes, and don't put in any spaces. Click OK. 

• "\\software\academic\geology\" will now be one of the available drives. 
Double click it, and then expand your course folder. 

• Locate the data you want to add by expanding either your own folder or your 
course Data folder. 

 
To save to your folder inside your course folder 
 

• Before saving your file to your folder, make sure that you will be saving relative, 
rather than absolute, path names. Go to File, Map Properties, Data Source 
Options, and click "Save relative path names" before saving your file. 

• Go to the File menu and select Save As.  
• Type \\software\academic\geology\ in the File name box.  
• Scroll down Geology, open the folder, scroll to your course folder, and select 

your personal folder (you may need to drag the corner of the list box to the right 
to see your name), and double click on the directory listing with your name to 
put it into the File name box. 

• Set the cursor at the very end of the listing following your name, and type a 
single backslash (if there isn't one there already) and add your file name. Keep 
your file name itself short, NO SPACES and NO SPECIAL CHARACTERS. Click 
OK. 
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Working with files and layers 
 

Naming Files and folders in ArcGIS 
• The crucial thing about folder and file names is that you must be absolutely 

certain that there are NO SPACES in folder or file names and no oddball 

characters. If you want a space in your folder or file name, you must put in an 

underscore. MAC USERS BEWARE. Spaces are OK in Mac file and folder 

names. They are not OK in ArcGIS. If you have trouble getting something to 

work in ArcGIS, the very first troubleshooting thing you should do is check all 

of your file/folder names to make sure that they have no spaces and no long 

names. 

• In Windows Explorer, the default location for saving files is a folder titled 

Documents and Settings, which, unfortunately, has spaces in the name. Even if 

you are careful to eliminate spaces in your file names, saving to the default 

folder means that you are dead in the water. That's why it's important to set up 

new folders that are not in the Documents and Settings folder and that have no 

spaces in the names into which you can save your files.  

• And, don't make a folder on the Desktop – ArcGIS does not like folders or files 
on the desktop. 

• Saving Relative Pathways in ArcMap. Before saving an ArcMap .mxd file to 
your folder, make sure that you will be saving relative, rather than absolute, 
path names. Go to File, Map Properties, Data Source Options, and click "Save 
relative path names" before saving your file. 

 

Renaming files and folders 
• If you want to rename a file, do so in ArcCatalog so that all of the related files 

are renamed at the same time. In ArcCatalog (not ArcMap), right click on the 

file name, and select Rename from the menu. 

• You can also do this by bringing up Layer Properties (either by double-clicking 

on the layer name in the TOC of ArcCatalog or by right-clicking on the layer 

name in ArcCatalog and selecting Layer Properties. Click the General tab, and 

type a new name in the layer name box, and click OK.  

 

Deleting files and folders 
• If you want to delete a file entirely, do so in ArcCatalog so that all of the related 

files are deleted at the same time. In ArcCatalog, right click on the file name, 

and select Remove from the menu. 

 

Adding data to your ArcMap file 
• Click on the add data icon (yellow diamond with a plus sign), and, in the Add 

Data dialog box, navigate to the file you want to add, and click OK. 
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• The new layer appears in the ArcMap TOC 

 
Managing data layers 

• To hide and show layers. Next to each layer name in the TOC, you'll see a box 

with a check mark. Clicking in that box allows you to toggle the visibility of a 

layer 

• Rearranging the order of layers. If you decide that you want to have the 

layers in a different order, simply click and hold on the name of the layer and 

drag it above or below any other layer in order to switch its position. The check 

box must be checked in order for you to actually see a layer, regardless of 

its position, although you may not be able to actually see a layer if it is 

obscured by an opaque overlying layer. 

 

Changing the display to lat/lon 
• Right click on the word Layers in the TOC, and select Properties to open the 

Data Frame Properties window. Click on the General tab, and, under 

Units/Display, select the units to whatever you want (e.g., Degrees Minutes 

Seconds, or meters). Click OK.  

• Moving the cursor over the map will now give coordinates in the new units, and 

the measure tool will measure in those units. 

 

Renaming layers in ArcMap 
• This is different from renaming a file. Renaming a layer in ArcMap changes the 

name only in the ArcMap TOC. You'd do this if the original file name is cryptic 

and you want to have something more descriptive in your ArcMap TOC, or if 

you want the names in a legend to be more descriptive than the file names (the 

map layout will use the layer names in the legend). 

• Right-click on the layer name, and select Rename. Type in a new name. Unlike 

most places in ArcMap, length and spaces don’t matter. Remember, too, that 

this is the name that ArcMap will put into a legend, if you choose to make one. 

• Just as deleting a layer in the TOC doesn't delete the original data file, 

renaming the layer in ArcMap TOC doesn't change the name of the 

original data file in ArcCatalog. If you rename something and can't remember 

what the original file name is, just double-click on the new layer name to bring 

up the Layer Properties dialog box (or right-click and select Layer Properties), 

and click the Source tab. Under Data Source, you'll see the location and 

name of the file that your layer is made from. 

 

Deleting layers in ArcMap 
• This is different from deleting a file. Deleting a layer in ArcMap only removes it 

from your map – it's still there in ArcCatalog. 
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• Right-click on the layer name, and select Remove.  

• Just as renaming a layer doesn't alter the name of the original data file, 

deleting the layer in ArcMap doesn't delete the original data file in 

ArcCatalog. If you delete something, you can always add it back in. 

 
Making a new shape file 

• Open ArcCatalog (not ArcMap!!!). In the TOC of ArcCatalog, navigate to the 

folder into which you want to save a new shapefile. Highlight the folder.  

• Go to the File menu in the main menubar, and select New, and Shapefile. Give 

your shape file a name (e.g., roads, and remember! Short! No spaces!). in the 

Feature Type pulldown menu, choose the right type of file (for points, pick 

Point; for lines, such as roads, pick Polyline; for areas, pick Polygon). You 

cannot change the shapefile type later, so be sure to choose the right kind of 

file when you create the shapefile. 

• Be sure to specify a coordinate system by clicking the Edit button and choosing 

a coordinate system. 

• Click OK to create the new shape file. Your new shape file should appear in the 

list.  

 
Making a copy before you edit a data file using ArcMap Editor 

• If you intend to edit a shape file in ArcMap using the ArcMap Editor, be sure to 

save a copy of the file in your own folder before editing. Do not edit the file in 

the original data folder. 

• Be sure to use ArcCatalog to make copies of files that you want to edit. 

Don't just go to the data folder and copy the file to your data folder, or you 

won't have all of the necessary yassociated "hidden" documents that go with the 

file.  

• To copy a file in Arc Catalog: Locate the file of interest in the ArcCatalog 

Table of Contents (the left hand window). Right click on the file name, and 

select Copy. In the ArcCatalog Table of Contents window, navigate to the folder 

where you want to paste the file (this must be one of your own folders, not the 

original data folder). Right click on the folder name, and select Paste. Doing 

this in ArcCatalog automatically copies all of the associated documents that go 

with the file. 
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Working with DEMs 
 
A Digital Elevation Model (DEM) is a way of visually portraying elevation data. Each 

piece of data consists of location information (lat and lon) plus elevation for a given 

small area on the Earth's surface. ArcMap takes the location and elevation data that 

are stored in the files and arranges them in their appropriate relative positions to 

create a map view of the data. That map can then be manipulated lots of ways 

electronically using ArcMap and the tools 3D Analyst and Spatial Analyst.  

 

The kind of data behind a DEM is called raster data. In raster data, information is 

stored for every pixel in the area of interest. Resolution is governed by the size of each 

pixel footprint. If each pixel represents the average elevation of a 10 m x 10 m square, 

the resolution of the image (ability to see fine detail) is better than if each pixel 

represents the average elevation of a 1 km x 1 km square. As resolution goes up for a 

given area, so does file size, because the number of pixels increases. 

 

Elevation data can be digitized from existing topographic maps, with elevations 

interpolated between contour lines. DEMs can also be created from surface elevation 

data measured from space by the Shuttle Radar Topography Mission (SRTM).  

 

Downloading Shuttle Radar Topography Mission DEMs 
The SRTM data base is a remarkable worldwide digital elevation data set for about 80% 

of the Earth's land surface. It took 10 days (only 10 days!!) to collect all of the data! 

The data set covers all land areas between 60°N and 56°S latitude (higher latitudes 

were excluded because of the inclination of the Shuttle orbit, which was 56°. The 

resolution of SRTM data is 30 m/pixel for the highest resolution data. The mission was 

flown in February of 2000, and one of the mission specialists, Janet Kavandi, was also 

on the mission that flew in July 2001 that flew the Hamilton College banner that's 

hanging in the Geo Department.  

 
The CGIAR/Consortium for Spatial Information has processed Shuttle Radar 

Topography Data for the world to eliminate any blank pixels, etc. It's much easier to get 

the data from this site than to go to the USGS site and deal with the raw data, which 

you would have to process to remove blank pixels before you could do, for example, a 

hillshade. If you were doing a research project, you'd want the original data, but, for 

what we're doing, this is a great and fast way to get SRTM data to work with. Go to the 

CGIAR site at http://srtm.csi.cgiar.org/ 

 

In the left hand link list, click on SRTM Data Search and Download 

• On the page that comes up, you'll see a  map of the world with a grid on it 

 (http://srtm.csi.cgiar.org/SELECTION/inputCoord.asp), This grid outlines tiles 

of SRTM data. Select the server JRC(IT). Note: CGIAR has five servers, three in 
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the US, one in Italy, and one in the UK. The folks at CGAIR say that data on the 

Italian server is most frequently updated and quality checked. The other servers 

eventually get the updates, but not immediately following changes to the Italian 

server. 

• Check to make sure that the GeoTIFF radio button is checked. After you select 

the server, a second line allows you to select a method of data selection. 

Multiple Selections allows you to choose multiple tiles, even non-adjacent 

ones. Enable Mouse Drag allows you to drag a selection. Input coordinates 

highlights the lat/lon input fields.  

• Choose your tile(s), and click on the tile(s) that you want.  

• If you blunder or want to change your mind, click Clear Area. Once you're 

satisfied, click Search. Another page will come up with tile details and a location 

map. If the area isn't what you want, just go back and try again.  

• When you're happy, click the Data Download button for each tile, and save the 

zipped file to your folder. Do not save the file to the desktop, because ArcGIS 

does not like files saved to the desktop.  

• To unzip the data, navigate to the folder, and right click on the folder. Select 

Extract all, and save it to your folder.  

o The data files should have a WGS84 coordinate system associated with 

it. Check to make sure in ArcCatalog under Metadata > Spatial tab. 

• If you have more than one adjacent tile, you must mosaic your SRTM data 

before projecting it. It’s easy to remember mosaic before projecting, because 

“m” comes before “p” in the alphabet. 

o In ArcCatalog, use Mosaic to New Raster tool. 

o Data Management Tools > Raster > Raster Dataset > Mosaic to New 

Raster 

o SRTM data Pixel Type is 16 bit Signed. 

o Do NOT specify a new projection for this raster in this step. 

• ***You must now project your SRTM DEM. The locations of pixels in your 

DEM are specified in decimal degrees. The mathematical equation that ArcMap 

uses to create a hillshade, however, assumes that pixel locations and elevations 

are all in the same units. In WGS84 the elevation is in meters while the X,Y 

values are in decimal degrees. If you try to make a hillshade from the 

unprojected SRTM DEM data, it will be all screwy. So, you need to project the 

DEM first so that X, Y, and Z are all in meters. 

o In ArcCatalog, open ArcToolbox, select Data Management Tools, 

Projections and Transformations, and Raster. Select the Project 

Raster tool.  

o For Input Raster, browse to your SRTM tiff file or mosaic if created. You 

can leave the output raster name as it's automatically put in, although 

you should check to make sure that the name is short and without 

spaces. If the name is too long, shorten it. 
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o Click on the button to the right of Output coordinate system, and 

choose Select. Select Projected Coordinate Sytems/Utm/Wgs1984. 

Now, you'll need to find the right UTM zone. Use the map on page 61 to 

determine the UTM zone, and select N, if you are north of the equator, 

and S if you are south (e.g., Cairo is UTM Zone 36N). Select the correct 

zone, and click OK, then OK again. 

o Change the Resampling Technique from NEAREST (default) to 

BILINEAR. 

o ****Scroll down to check the Output Cell Size box.*** Once the output 

coordinate system is entered, the Output Cell Size box should show a 

number in the range of 85-110 meters or so. If it isn’t, you’ve done 

something wrong. Click OK again for all your selections and again to 

project the raster. Wait while the Executing Project Raster dialog box is 

busy. Close when done.  

•  Your DEM is now ready to add to an ArcMap. 

 
Downloading New York State DEMs from the CUGIR site 
The Cornell University Geospatial Information Repository has DEMs at 10 m resolution 

for all of New York State. To download NYS DEMs: 

• Go to http://cugir.mannlib.cornell.edu/  

• Click the Map Browse tab. Click the 1:24,000 quads tab, and select the county 

you’re interested in. 

• Roll the cursor over the quads until you find the quad you want, and click on it. 

A listing of the data sets available for the quad at the CUGIR site comes up. It 

lists three data sets: 7.5 minute topographic maps, elevation (DEM data), and 

hydrography. We're interested in the DEM data. 

• Put a check in the box in the far left column next to elevation. At the top right 

of the data list, click on the button labeled Add Checked Data Files to Basket. 

A new window opens showing the number of items in the basket, the size of the 

basket in megabytes, a button to update the basket, and a button to download 

selected.  

• Click Download Selected, and a new window will appear listing the file to 

download with a name starting with CUGIR followed by the date, time, and a file 

number, such as CUGIR_2007-02-03-11-22-35-690.zip.  

• Click on the red CUGIR file name. A file download dialog box will open. Click 

the Save button. A Save As dialog box will open. Navigate to your folder on the 

C:/ drive, and click Save. Be sure that the folder name is SHORT and has NO 
SPACES. ****FOR GIS work, remember that file and folder 
structure will be very important as we work this semester.**** 
It's very easy to get a whole long list of files in your folder on 
the server that you can't navigate around. Close this box once the 

download is complete. 
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The DEM data that you just downloaded from CUGIR are compressed (zipped) files. The 

CUGIR data require a two-step decompression process.  

 

• To unzip the DEM folder from CUGIR in your folder: 

o In Windows Explorer (not ArcCatalog) navigate to your folder on the C:/ 

drive. 

o Right click on the zipped folder and scroll down to Extract All. 

o Extraction Wizard opens, click Next, and the Wizard creates a default 

folder to extract the files to. This folder will have the same name as the 

original folder without the .zip extension and will automatically be placed 

into your folder.  

o Click Next, and the extraction progress bar appears, and the files are 

extracted.  

o When the extraction is done, click Finish. The default when clicking 

Finish is to show the decompressed folder, which looks exactly like the 

original one without the zipper. Double click this folder to open it. 

o The unzipped folder will have several documents in it, including a .gz file, 

which is another type of compressed file. You must now decompress the 

.gz file before you can use the DEM data in ArcGIS. 

 

• To decompress the .gz file from CUGIR that is now in your unzipped CUGIR 

folder: 

 

o Right click on the .gz file, select 7-Zip, and select Extract Here.  

 

Once you have decompressed your DEM data, launch ArcCatalog, and navigate to your 

folder on the C:/ drive.  

 

• Explore the folder that you have just downloaded, and preview the DEM. 

Remember to say “yes” to pyramids, if it asks to build them. Pyramids improve 

the speed at which ArcCatalog and ArcMap can display data. 

• But, yikes! Your DEM looks like a plain black rectangle! No worries. This is 

because ArcGIS cannot read USGS DEMs directly, and the data need to be 

converted to a format that ArcCatalog/ArcMap can display. Fortunately, this is 

quick and easy. 

o In ArcCatalog, find the red Toolbox icon in the ArcCatalog menu bar, and 

click on it to open ArcToolbox (if it is not already open). 

o Expand the Conversion Tools by clicking on the + sign. Expand the To 

Raster toolbox by clicking on the + sign. Double click on the DEM to 

Raster tool to open it. 

o In the DEM to Raster tool, browse to your DEM for conversion by 

clicking on the folder next to the field titled Input USGS DEM file.  This 

will be the xxxelu.dem file in the unzipped folder. A default path and 
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name for the output DEM will be automatically entered in the Output 

raster field.  

o Here is where you should change the xxxelu.dem to a more meaningful 

name. Click on the browsing folder on the right side of the Output raster 

field, and navigate to the top level of your working folder (i.e., you don't 

have to bury this inside the nested CUGIR folders). Name the file 

something appropriate and short. Rasters with no suffix on them are 

called GRID files and can have a maximum of 13 characters in the name. 

Don't add any extensions (e.g., don't add .dem at the end – you can have 

_dem, but not .dem). Leave the defaults as set, (FLOAT and Z factor of 1), 

and click OK.  

o A dialog box will open showing that the tool is running, and the new file 

will appear in the folder.  

o When it's done, preview the file in ArcCatalog, and it will look fine! You 

may need to go to the View menu and choose Refresh, if your file does 

not appear. This is the file that you will add to create your ArcMap. 

 
Downloading ASTER Global Digital Elevation Model (GDEM) data  
Japanese researchers have created a new global DEM data set using ASTER satellite 

imagery. This data set is unique in a number of ways. ASTER DEMs 

• extend to higher latitudes (up to 83o north and south) than the SRTM DEMs, 

which extend only to about 58° north and south.  

• have 30 meter/pixel resolution worldwide. SRTM DEMs outside the United 

States are at 90 meters/pixel. 

• are derived from visible imagery and have better data in high relief areas than 

SRTM data, which has “holes” due to loss of radar return signal. 

 

The ASTER DEM data, called GDEM for Global Digital Elevation Model, is currently only 

available for download at www.ersdac.or.jp/GDEM/E/index.html To access and 

download the data, go to the website and click on the ASTER DEM button. 

• You must be registered to select and download data (registration and data 

download is free). In the left hand column under Operation heading, click 

Register, and follow the instructions. 

• Once you are registered, log in, and click the Search button in the Operation 

list. A typical map based browser opens. Click on the Select tiles directly tab. 

• Use the scroll arrows to move around the map, and use the zoom bar to zoom in 

and out. The # Grid button turns on & off a grid of tile locations. 

• Click Start to begin selecting tiles. With you tiles selected, click the Next button, 

and a list with your selected tiles appears. At this point, you can uncheck any 

files that you do not want to download. Click Next. 

• From the pull down menu, select a purpose (it doesn’t matter what you chose). 

Read the End User Agreement, and click Agree. A list of tiles appears. 
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• You can download individual tiles by clicking the download button beside each 

individual file, or you can use the Download button at the bottom right to 

download all tiles in the list as a single zipped file. Do not download more than 

100 tiles at a time. 

• Expanding the zipped file labeled “Tiles….” creates a folder containing zipped 

folders for each of the downloaded tiles. Each of these folders must be unzipped 

as well. 

o Each tile folder is named with the lat/long of the lower left corner of the 

tile. 

o Each individual folder contains two files, a _dem.tiff and a _num.tiff. The 

_dem.tiff file is the one that is used. 

• If you have downloaded more than one GDEM tile, mosaic them as described 

under the SRTM data section on page 16. Remember the “M before P rule” 

(Mosaic before Projecting) . 

• GDEMs, like SRTM DEMs, are in the GCS WGS 84 geographic coordinate 

system and must be projected before they are used to create hillshades. Refer to 

the SRTM section on page 16 on projecting DEMs. Note that GDEMs are 16 bit 

signed data. 
 
Mosaicking your DEMs (Mosaic SRTM data before Projecting, See 
section on downloading SRTM data) 
Open a new ArcMap, and add all of your DEMs. You now need to mosaic them together 

so that they behave as one unit for hillshading and colorizing. 

 Click on ArcToolbox (the red toolbox in the menubar). Scroll down to Data 

Management Tools, Raster, Raster Dataset, and select Mosaic to new raster. 
 In the dialog box, click the down arrow under Input Rasters, and add your first 

DEM. Click the arrow again, and add the second DEM. Continue until you have 

all of your DEMs in the list. 

 This mosaicking tool mosaics all of the DEMs to a new DEM. Click on the 

folder next to Output Location, and choose a folder to put your mosaicked DEM 

into. Wait until the folder name appears in the box. Enter a name into the 

Raster Data Set Name box (remember: short, no spaces). Then, scroll down  

until you see the Pixel Type pulldown. 

o If you have an SRTM DEM (e.g., one downloaded from the CGIAR 

site): select 16_BIT_SIGNED  

o If you have a NYS DEM from CUGIR (NOTE!!! “CUGIR” is NOT the 

CGIAR site where you can download SRTM DEMs!): select 32_BIT_FLOAT 

o If you have another type of DEM: go back to the TOC and right click on 

the DEM name, select Properties, and choose the Source stab. Scroll 

down to find the Pixel Depth and the Pixel Type. In the Mosaic to New 

Raster dialog box, select that pixel type. 

Click OK. Your new mosaicked DEM will be automatically added to your ArcMap. You 

can delete all of the other DEMs. 
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Making a hillshade of a DEM 
• Be sure that you have projected your DEM first if you are using an SRTM 

DEM (see previous header). If you are using a CUGIR DEM, you’re all set. 

• Check to be sure that the Spatial Analyst extension is turned on. Go to the 

main menu and select Tools, then Extensions. Make sure there is a check 

mark in the Spatial Analyst box. You’ll also need to add the Spatial Analyst 

toolbar by going to the View menu, and selecting Toolbars and then Spatial 

Analyst.  

• Click on the word Spatial Analyst in the toolbar, select Surface Analysis, and 

then Hillshade. If the word "Hillshade" is grayed out, you forgot to add the 

Spatial  Analyst extension.  

• In the Hillshade dialog box, choose your DEM from the Input Surface pulldown, 

and leave all but the last setting at the default values. You must now replace 

<Temporary> in the Output raster box with a permanent file name, or your 

hillshade will not be saved. Click the folder icon next to the Output raster 

box, and navigate to your own data folder. Call this new file something simple 

and descriptive. Remember!!! NO spaces, NO odd characters, and SHORT. 

Use the default file type (ESRI GRID). Click OK, and then OK again in the 

Hillshade menu. 

• Note: choosing your DEM from the pulldown list (rather than navigating to 

it via the folder icon next to Input) and naming your new hillshade by 

using the folder icon next to Output (rather than just typing a name into 

the box) are crucial!! If your hillshade fails to execute, you may have failed to 

do one of both of these things.  

• In the TOC, you'll see your new layer (with the name you called the file) appear 

at the top of the list. You'll also see the map view of your layer, this time as a 

shaded relief image. Notice that your lat/lon coordinates still work. You can 

toggle this layer on and off, and you can move it around just like you did with 

the other layers. 

 

Creating a color ramp DEM with a semi-transparent hillshade 
• Make sure that, in the TOC, the hillshade is above the DEM. If that's not the 

order you have, rearrange by dragging and dropping. 

• Right click the hillshade layer, and scroll down to Properties. Click the Display 

tab, and change transparency to 30% by typing in 30. Do NOT click OK. Drag 

the properties window partly out of the way so that you can see most of the 

map. Click apply, rather than OK. This allows you to try out various 

transparencies before committing yourself. Once you have what you like, and 

can see the DEM through the hillshade, click OK. You can always go back and 

change this later, if you change your mind as you go along. 

• This is a better image, but it's still a little blah. Let's colorize it! 
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• For the next steps, be sure that you're working with the DEM, not your 

hillshade!! Right click on the DEM, and select Properties. Click on the 

Symbology tab. Make sure that Stretched is highlighted in the left column, 

and right-click on the black-to-white color ramp bar. Select Graphic View to 

uncheck it, and the color ramp should now have text instead of a color 

gradation in it.  

• Scroll down to Elevation #1, and select it. Set the Stretch type to None. 

• Click apply, and drag the Layer Properties window out of the way to see what 

you've done. You can check out other color ramps as well. When you have what 

you like, click OK, and save. 

• To see what the DEM looks like all by itself, you can turn off the hillshade. If 

you do this, you'll see why both the hillshade and the colorized DEM are 

necessary for the full 3D effect. 

• Your map may look a little faded with the transparency of the hillshade set to 

30%. That's because you're looking through a hillshade that is only 30% 

transparent. You can adjust the transparency of the hillshade so that you can 

see more of the color of the DEM through it.  

 

Viewing a hillshade in 3D using ArcScene 
• The extension 3D Analyst allows us to view a hillshade in 3D and rotate the 3D 

view. Check to be sure that the 3D Analyst extension is turned on. Go to the 

main menu and select Tools, then Extensions. Make sure there is a check 

mark in the 3D Analyst box. Check to be sure that your 3D Analyst toolbar is 

visible.  

• If your hillshade is partially transparent, go to Display under Layer 

Properties, and reset the transparency so that your hillshade is opaque. 

• Locate the ArcScene icon in the 3D Analyst toolbar. It's the one second from the 

right hand end of the toolbar and looks like a circle with two yellow Post-Its (if 

you hold the cursor over an icon without clicking, a box will appear telling you 

what the icon does – if you have the right one, the box will say ArcScene). 

• Click the ArcScene icon, which launches ArcScene and brings up a new 

window that has elements that look a lot like ArcMap except that the TOC is 

headed by the words Scene layers, and the menu bar is a bit different. 

• Use the Add Data icon to add a hillshade file. Save your new ArcScene map to 

your data folder. 

• Locate the icon in the ArcScene toolbar that looks like a globe with four arrows.  

This is the Navigate icon. Click on it. The cursor will now look like the Navigate 

icon, and clicking and dragging the cursor across the map window will tilt and 

rotate the hillshade that you've added. Right-clicking will let you zoom the 

image in and out. The center wheel of the mouse also zooms the image in the 

map window. 
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• Notice, though, that you only have the illusion of 3D. Although the hillshade 

makes it look 3D, the scene is a flat sheet when you rotate it to look at it edge 

on. So, we need to extrude each pixel according to its real elevation. 

• Start by tilting and rotating the scene until it looks like it originally did – 

clicking the "world" resets to the original view.  

• Right click on the layer name in the TOC, and select Properties. Choose the 

Base Heights tab, and click the radio button next to Obtain heights for layer 

from surface. You want ArcScene to get the elevations from your original DEM, 

so you a have to direct ArcScene to find the right file that has the original 

elevations for your hillshade. Click the folder icon, and navigate to the original 

raster image data file. Click Add. Don't change the other defaults, and click OK. 

• Now, get the Navigate tool from the toolbar, and tilt and rotate. You can even 

view it from below!! Just be sure that you obtained the heights from the correct 

original data layer, not from a hillshade layer. 

• If you want to increase the vertical exaggeration, right click on Scene Layers at 

the top of the TOC (not on one of your individual layers). Choose Scene 

Properties, and click the General tab. Under vertical exaggeration, choose 

something other than None. Click OK. If the scene disappears from view, you've 

chosen a vertical exaggeration that is too great. If that happens, go back and 

select a vertical exaggeration of 1.5 or 2. If the vertical exaggeration creeps you 

out, repeat the process, and change it back to None. 

 

Flying through a 3D model in ArcScene 
• Get the Fly tool (looks like a seagull).  

• Left click flies you toward the scene. The more clicks, the faster you go. Right 

clicking slows you down until you stop. Then, right clicking more flies you away 

from the scene etc. etc. If you get going too fast, click the other button 

repeatedly until you slow down and stop (the seagull stands on the ground).  

• If all hell breaks loose and you go at warp speed through the model, hit the Esc 

button on the keyboard. If you've lost your model, just click on the globe tool to 

center the model again. Moving the seagull right, left, up, and down lets you fly 

up or down and turn right or left. Play around a bit. If you want to stop, just 

click the right button a few times until you stop moving. 
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 Creating and working with shapefiles 
 

Creating a new shapefile 
 Open ArcCatalog (not ArcMap!!!).  

 In the TOC of ArcCatalog, navigate to the folder where you want to save your 

shapefile. Highlight the folder.  

 Go to the File menu in the main menubar, and select New, and Shapefile. Give 

your shape file a name (e.g., roads, and remember! Short! No spaces!).  

 In the Feature Type pulldown menu, choose the right type of file (for points, 

pick Point; for lines, such as roads, pick Polyline; for areas, pick Polygon). 

Once you have created a shapefile, you cannot change the file type. So be sure 

to pick the file type you want. 

 Click the Edit button to navigate to and select a coordinate system that matches 

the coordinate system of the ArcMap to which you will add this shapefile. OK the 

coordinate system, and click OK again to create the new shape file. Your new 

shape file should appear in the list.  

 

Adding points to a point shapefile 
 ****Very important!!!**** You are about to edit the shapefile. Anything that 

you do in ArcMap to edit the shapefile changes the original shapefile. If you 

want to keep a copy of your original, unaltered shapefile, you should go back to 

ArcCatalog, right click on the shapefile in the TOC, choose Copy, and navigate 

to the folder where you want to store your original. In order to paste, the 

destination folder must be highlighted. Once your destination folder is 

highlighted, select Paste from the Edit menu of the main menubar. You can 

rename the file you have just pasted by right clicking on the name in the TOC of 

ArcCatalog and selecting Rename. 

• Once you are sure you're about to edit the right file, navigate to ArcMap, and 

add the shapefile. 

• Locate the Editor toolbar, and click on the triangle to expand it. Select Start 

Editing. If you don't see the Editor menus, go to View, Toolbars, and make 

sure that the Editor toolbar is checked.   

• Click on the Pencil, and make sure that Create New Feature is chosen in the 

Task box. In the Target Layer pulldown, select your new shape file. 

• Each time you click on the map, a new point will be added and will appear in 

sequential order in the attribute table. 

• You can save your edits at any point by going to the Editor pulldown and 

selecting Save Edits. When you are done adding points, you must choose Stop 

Editing. If you haven't saved, ArcMap will prompt you to save your edits.  

• You can edit the size and color of the symbols by left clicking on the symbol in 

the TOC. 
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Adding lines to a line shapefile 
 ****Very important!!!**** You are about to edit the shapefile. Anything that 

you do in ArcMap to edit the shapefile changes the original shapefile. If you 

want to keep a copy of your original, unaltered shapefile, you should go back to 

ArcCatalog, right click on the shapefile in the TOC, choose Copy, and navigate 

to the folder where you want to story your original. In order to paste, the 

destination folder must be highlighted. Once your destination folder is 

highlighted, select Paste from the Edit menu of the main menubar. You can 

rename the file you have just pasted by right clicking on the name in the TOC of 

ArcCatalog and selecting Rename. 

• Once you are sure you're about to edit the right file, navigate to ArcMap, and 

add the shapefile. 

• Make sure that your map units are set to a conventional distance unit of 

measure (e.g., meters, feet, or km, rather than degrees). Right click on the Data 

Frame name in the TOC, select Properties, General, and set the display to the 

units you want. Click OK. Now, as you move the cursor, you should see the right 

units at the bottom of the screne. 

• Creating a line by streaming 

o The instructions below are for creating a line by Streaming, which is an 

easy way to draw a smooth curve. As you move the cursor, ArcMap will 

automatically add control points at whatever distance interval (the 

stream tolerance) you select. If you want to create a line by point and 

click, go to the next set of instructions. 

o Locate the Editor toolbar, and click on the triangle to expand it. Select 

Start Editing. If you don't see the Editor menus, go to View, Toolbars, 

and make sure that the Editor toolbar is checked. 

o Click on the Editor menu again, and select Options. Click the General 

tab. Enter a value for stream tolerance in map units. You must enter a 

value other than 0 (which is the default). The value that you choose will 

tell ArcMap how close together the control points will be for the curve, 

and it uses map units. This is why it was important to change the 

display units to something more meaningful than degrees. You can 

experiment around with this and even change it after you have started to 

draw a line. Type in a value for stream tolerance and type in a value for 

“Group”. This will tell ArcMap how many points to delete at the same 

time if you click the Undo arrow (the curved arrow located left of the 

yellow Add icon). Try 20. Again you can change this on the fly. Click OK. 

o Click on the Sketch tool (looks like a pencil) in the Editor menu bar, and 

make sure that Create New Feature is chosen in the Task box. In the 

Target Layer pulldown, select your new shape file. 

o Use your left hand to press the F8 key to start streaming, and keep your 

left forefinger hovered over the F8 key. Click where you want to start the 

line, and trace the curve. ArcMap will add control points for you. If you 
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make a mistake or need to stop, immediately press the F8 key to stop 

streaming. As long as you don’t click the mouse again, you can move the 

cursor to various menu bar items and click them without hurting your 

new partially completed line. You can undo with undo arrow, you can 

scroll the window, you can click on the Editor pulldown and save edits or 

change your streaming settings.  

o When you are ready to add another portion of your line, press F8 again, 

and click and drag the next part of the curve. Just be sure not to click 

directly on the last point of the previous section, or it won’t work. 

ArcMap will automatically connect your new section to your old one. 

Save Edits often, because you an always undo a huge blunder. To save 

edits, go to the Editor dropdown menus, and select Save Edits. 

o When you are ready to finish your line, double click the mouse. Be very 

careful not to double click until you are completely done.  

o Once you have double-clicked, the line will be a wide, bright cyan 

feature. That means that it is selected. If you draw another line and 

double click at the end, the first one becomes de-selected in favor of the 

second one. Don't worry at this point if you don't like the color or weight 

of the line. 

 Creating a line by point and click 

o If you don’t want to stream, you can make a line by clicking individual 

control points. ArcMap will draw straight lines between each of the 

control points (called vertices). 

o Locate the Editor toolbar, and click on the triangle to expand it. Select 

Start Editing. If you don't see the Editor menus, go to View, Toolbars, 

and make sure that the Editor toolbar is checked. 

o Click on the Sketch tool (looks like a pencil) in the Editor menu bar, and 

make sure that Create New Feature is chosen in the Task box. In the 

Target Layer pulldown, select your new shape file. 

 Click once where you want your line to start, move the mouse a little, 

and click again. Keep moving and clicking until you get to the end of the 

line you want to draw, at which point you must double-click. The 

straighter the line, the fewer the points you need. On the other hand, if 

you have a really curvy line and you click only a few points, it will be a 

bit herky jerky. As you are doing this, be very careful to single click 

only – as soon as you double click, ArcMap will finish your line for you. 

Save your edits often. To do this, you must go to the Editor dropdown 

menu and click Save Edits. 

• Once you have double-clicked, the line will be a wide, bright cyan 

feature. That means that it is selected. If you draw another line and 

double click at the end, the first one becomes de-selected in favor of the 

second one. Don't worry at this point if you don't like the color or weight 

of the line. 
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• Each line that you add will appear as a separate item in the attribute table. 

• You can save your edits at any point by going to the Editor pulldown and 

selecting Save Edits. When you are done adding lines, you must choose Stop 

Editing. If you haven't saved, ArcMap will prompt you to save your edits.  

• You can edit the size and color of the symbols by left clicking on the symbol in 

the TOC. 

 

Adding a polygon to a polygon shapefile 
 If you don’t already have a shapefile to add a polygon to, go to page 23 and 

create a new shapefile. 

 ****Very important!!!**** You are about to edit the shapefile. Anything that 

you do in ArcMap to edit the shapefile changes the original shapefile. If you 

want to keep a copy of your original, unaltered shapefile, you should go back to 

ArcCatalog, right click on the shapefile in the TOC, choose Copy, and navigate 

to the folder where you want to story your original. In order to paste, the 

destination folder must be highlighted. Once your destination folder is 

highlighted, select Paste from the Edit menu of the main menubar. You can 

rename the file you have just pasted by right clicking on the name in the TOC of 

ArcCatalog and selecting Rename. 

• Once you are sure you're about to edit the right file, navigate to ArcMap, and 

add the shapefile. 

• Make sure that your map units are set to a conventional distance unit of 

measure (e.g., meters, feet, or km, rather than degrees). Right click on the Data 

Frame name in the TOC, select Properties, General, and set the display to the 

units you want. Click OK. Now, as you move the cursor, you should see the right 

units at the bottom of the screne. 

• Creating a polygon by streaming 

o The instructions below are for creating a polygon by Streaming, which is 

an easy way to draw a smooth curve. As you move the cursor, ArcMap 

will automatically add control points at whatever distance interval (the 

stream tolerance) you select. If you want to create a polygon by point 

and click, go to the next set of instructions. 

o Locate the Editor toolbar, and click on the triangle to expand it. Select 

Start Editing. If you don't see the Editor menus, go to View, Toolbars, 

and make sure that the Editor toolbar is checked. Select the right folder 

that contains your shapefile. 

o Click on the Editor menu again, and select Options. Click the General 

tab. Enter a value for stream tolerance in map units. You must enter a 

value other than 0 (which is the default). The value that you choose will 

tell ArcMap how close together the control points will be fore the curve, 

and it uses map units. This is why it was important to change the 

display units to something more meaningful than degrees. You can 

experiment around with this and even change it after you have started to 
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draw a polygon. Type in a value for stream tolerance and type in a value 

for “Group”. This will tell ArcMap how many points to delete at the same 

time if you click the Undo arrow (the curved arrow located left of the 

yellow Add icon). Try 20. Again you can change this on the fly. Click OK. 

o Click on the Sketch tool (looks like a pencil) in the Editor menu bar, and 

make sure that Create New Feature is chosen in the Task box. In the 

Target Layer pulldown, select your new shape file. 

o Right click where you want to start the polygon outline, and select 

streaming. Trace the curve. ArcMap will add control points for you. If 

you make a mistake or need to stop, click on the map to pause 

streaming. As long as you don’t click the mouse again, you can move the 

cursor to various menu bar items and click them without hurting your 

new partially-completed polygon. You can undo with undo arrow, you 

can scroll the window, you can click on the Editor pulldown and save 

edits or change your streaming settings.  

o When you are ready to add another portion of your polygon, make sure 

that the pencil tool is selected, and simply click on the map again, and 

drag the next part of the curve. Just be sure not to click directly on 

the last point of the previous section, or it won’t work. ArcMap will 

automatically connect your new section to your old one. Save Edits 

often, because you can always undo a huge blunder. To save edits, go to 

the Editor dropdown menus, and select Save Edits. 

o When you are ready to finish your polygon, double click the mouse, and 

ArcMap will connect your last point with your first one with a straight 

line and fill in the polygon. Be very careful not to double click until 

you are completely done.  

o Once you have double-clicked, the line will be a wide, bright cyan 

feature. That means that it is selected. If you draw another polygon and 

double click at the end, the first one becomes de-selected in favor of the 

second one. Don't worry at this point if you don't like the color or weight 

of the line. 

 Creating a polygon by point and click 

o If you don’t want to stream, you can make a polygon by clicking 

individual control points. ArcMap will draw straight lines between each 

control point. 

o Locate the Editor toolbar, and click on the triangle to expand it. Select 

Start Editing. If you don't see the Editor menus, go to View, Toolbars, 

and make sure that the Editor toolbar is checked. 

o Click on the Sketch tool (looks like a pencil) in the Editor menu bar, and 

make sure that Create New Feature is chosen in the Task box. In the 

Target Layer pulldown, select your new shape file. 

 Click once where you want your polygon outline to start, move the mouse 

a little, and click again. Keep moving and clicking until you get to the 
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end of the polygon you want to draw, at which point you must double-

click. The straighter the line, the fewer the points you need. On the other 

hand, if you have a really curvy line and you click only a few points, it 

will be a bit herky jerky. As you are doing this, be very careful to 

single click only – as soon as you double click, ArcMap will finish your 

polygon for you. Save your edits often. To do this, you must go to the 

Editor dropdown menu and click Save Edits. 

• Once you have double-clicked, the line will be a wide, bright cyan 

feature. That means that it is selected. If you draw another polygon and 

double click at the end, the first one becomes de-selected in favor of the 

second one. Don't worry at this point if you don't like the color or weight 

of the line. 

• Each polygon that you add will appear as a separate item in the attribute table. 

• You can save your edits at any point by going to the Editor pulldown and 

selecting Save Edits. When you are done adding polygons, you must choose 

Stop Editing. If you haven't saved, ArcMap will prompt you to save your edits.  

• You can edit the size and color of the symbols by left clicking on the symbol in 

the TOC. 

 

Fixing blunders 
If you try to fix something, and you can't, remember that you have to Start Editing 

before you can add or modify. Just be sure to Stop Editing when you are done and be 

sure that you have saved your edits. 

 If you make a mistake and want to delete a point, line, or polygon, Start 

Editing, switch to the Selection tool next to the pencil tool on the editor 

toolbar. Right click on the item you want to remove, and select Remove.  

 If you want to move an item, Start Editing, switch to the Selection tool next to 

the pencil tool, Click and hold on the item, and drag it to the new location. 

 If you just want to reshape a line or polygon by moving one of the points around 

a bit, Start Editing, and switch to the Selection tool next to the pencil tool, 

select Modify Feature from the Task menu, click on the line to highlight it and 

bring up the control points, and drag whatever control points you want to 

reshape the line or polygon. If you need to add a control point, right click on the 

offending segment, and select Insert vertex. Click and drag to move it where 

you want it. 

 ***Be sure to switch back to Create New Feature and the Pencil tool when you 

want to add another item. 

 Be sure to Save Edits and Stop Editing when done. 

 

Labelling items in a shapefile 
  If your shapefile already has a field that you want to use for labeling attributes, 

you don't need to do the following. If you need a field for labeling, then follow the 

instructions below. 
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 If you are still editing, start by selecting Stop Editing and saving your edits. 

• Go to the TOC, and right click on your shapefile layer name. Select Open 

Attribute Table. 

• From the Options pulldown in the lower right, select Add Field. If Add Field is 

grayed out, you forgot to Stop Editing before opening the attribute table. Just 

close the attribute table, Stop Editing, and then open the attribute table again. 

• In the Add Field box, type a short name for the field in caps, no spaces (e.g., 

NAME). From the Type pulldown, select Text. In the Length box, type 25 (that's 

the maximum number of characters that the field will hold, and it's a pain if it's 

too long and a disaster if it's too short – this cannot be changed later!!). 

• Click OK, and you'll see a new field. To add anything to the new field, you 

have to Start Editing again.  

• Click in each box of the new field, and add the name. Be sure to add the right 

names to the right features! To make this easy, you can alternate between 

adding a feature to the map and adding its name to the attribute table. When 

you are done, select Stop Editing from the Editor menu. Close the attribute 

table. 

• The names don’t appear, because you haven't yet added them as labels. 

Remember that you can do this by right clicking on the layer name, selecting 

Properties, and Labels. Be sure to check Label features in this layer, select 

the correct field name from the Label Field pulldown, and make whatever 

choices you want in the fonts area. Click OK. If your labels don't appear, you 

forgot to check Label features in this layer. 
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Working with attributes 
 

Opening an attribute table 
• Right click on the shapefile in the ArcMap TOC, and select Open Attribute 

Table. This will bring up the attribute table for the layer.  

• Each column is called a Field.  

 

Selecting by attributes 
Selecting individual items in an attribute table 

• Make sure nothing is already selected on the map by choosing Selection from 

the main menu, and Clear Selected Features. 

• Make sure also that you have Stopped Editing. 

• In the attribute table, click in the space to left of the row containing the item(s) 

that you want to select. Features associated with this row in the attribute table 

will appear with cyan highlights on the map. 

 

Selecting a range of pixels in a DEM by their elevations 

• Start by making certain that there is nothing selected in your map. Go to the 

main menu at the top of the screen, under Selection, and choose Clear 

Selected Features. 

• Make sure also that you have Stopped Editing. 

• Go to ArcToolbox, Spatial Analyst Tools, Extraction, and Extract by 

Attribute. 

• For the Input Raster, select your original DEM (not the hillshade!!). 

• Click on the box to the right of the Where Clause field. Double click Value to 

enter it into the query box.  

o If you want all pixels less than or equal to a certain elevation, single click 

the <= button. Click the Get Unique Values bar, and double-click on 

value you want in the list (e.g., 134). You should now have a statement 

in the query box that says Value<=134. If it doesn't say this, select 

what's in the query box, delete it, and start over. When you have it right, 

click OK. 

o If you want all pixels equal to a certain value, single click on the = button 

and follow the instructions above. 

o If you want all pixels greater than a certain value, single click on the >= 

button and follow the instructions above. 

• Click the folder icon to the right of the Output raster field, navigate to your own 

folder, and name your new raster ExtractminXXX (no spaces!). Click OK. If your 

ExtractminXXX layer is not at the top of the TOC list, drag it to the top. 



 

version of 12-10-09 Barbara Tewksbury, Hamilton College (btewksbu@hamilton.edu) page 34 

• ArcMap should now have extracted all of the pixels that you have specified, but 

they are color shaded by elevation. In order to see them better, you can make all 

of these pixels one color. 

o Open the layer properties for your ExtractminXXX layer. 

o Select the Symbology tab, and choose Classified instead of Stretched. 

o Change Classes to 1. Double click on the color square in the list under 

the word Symbol, and select the color you'd like. You can always change 

this later if you don't like it. 

 

Adding a field to an attribute table 
• Start by making certain that there is nothing selected in your map. Go to the 

main menu at the top of the screen, under Selection, and choose Clear 

Selected Features. 

• Make sure also that you have Stopped Editing. 

• Open the attribute table, click Option in the attribute table window, and select 

Add Field. Name the field something short with no spaces (e.g., AREA).  

• Select the type of field you want from the Type menu.  

o Short integer: numbers with no decimal points and ranging from -32,768 

to 32,767. 

o Long integer: numbers ranging from -2,147,483,648 to 2,147,483,647 

and with no decimal points. 

o Float vs Double: both have decimal points. Use Float for smaller 

numbers with less precision. 

o Text: for entering names or other text; specify character length. Plan 

ahead in your estimate. This cannot be changed later, and making it 

too long is as bad as too short. 

• Select the precision and the scale 

o Precision specifies the maximum number of digits allowable in the field 

(e.g., 15). 

o Scale specifies the number of digits to the right of the decimal point. 

• Click OK. 

 

Adding data to an attribute table 
• Open the attribute table; add a new field if you need to by following the 

directions above. 

• Go to the Editor, and Start Editing. Note: if you Start Editing, and then try to 

add a field to the attribute table, it won't work. If this happens, Stop editing, add 

the field, and then start editing again. 

• Click in the field, and type what you need to. Save edits, and Stop editing. 
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Calculating in an attribute table 
• Open the attribute table; add a new field into which your calculated values will 

be entered (directions for adding a field appear above). 

• Go to the Editor, and Start Editing. Note: if you Start Editing, and then try to 

add a field to the attribute table, it won't work. If this happens, Stop editing, add 

the field, and then start editing again. 

• Click the header in the new calculation field. Select Calculate Values. 

• Use the formula builder to add fields and operations. Type in any constants that 

you need. Click OK. 

• Save Edits, and Stop Editing. Your new field will fill with calculated values. 
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Measuring elevations, distances, areas,  
and volumes, and calculating evaporative losses 

 

Finding the elevation of a point 
• Select the Identify tool (the one with the "I"). 

• In the pulldown menu of the Identify Results dialog box, select the layer that has 

your elevation data. If you do not do this, ArcMap will automatically select 

the topmost layer, which could be anything. If you fail to select the DEM, the 

values that you determine may not be elevation data. 

• Click on a location, and the elevation will be returned in whatever units you 

have the Units/Display set to. 

 

Measuring distances 

• Right click on the word Layers at the top of the TOC, and choose Properties. 

Click the General tab, and check to see what the units are. If necessary, 

change  to whatever units you need. 

• Select the measure tool in the toolbar (looks like a ruler). Center the cross of 

the cursor at one end/side of what you want to measure on the map, click, and 

drag to the other end/side. Double click to end. The length appears in the lower 

left of the screen.  

 

Measuring areas 

ArcMap can calculate the area of a polygon in a shapefile, provided that the projection 

of the shapefile matches that of the map. ArcMap cannot calculate area on a raster 

image. If you have a raster image, the simplest thing to do is to create a new shapefile 

and draw a polygon outlining the area that you wish to measure. 

 

• Start by making a new shapefile, add it to your ArcMap, and draw a polygon of 

the area (pages 25 and 28-30). 

• Be sure that you have Stopped Editing and saved your edits before going on 

to the next step. 

• Start by looking at the attribute table for your polygon layer (right click in TOC 

and select Open Attribute Table). You'll notice that each polygon you've drawn is 

a separate polygon listed in the order in which you added them (Lake 1 is 0, 

Lake 2 is 1, etc.), but that there are no data associated with any of the polygons. 

You need to tell arc map to calculate the areas and create a new attribute table. 

• Go to ArcToolbox, open Spatial Statistics Tools, and then Utilities. Select 

Calculate Areas. 

• Input your new polygon layer (scroll down and select it). Under Output Feature 

Class, navigate to your folder and save the output file as area (or something like 

that). The new file automatically adds as a layer. 
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• Open the attribute table for this new layer. Voila! The area of each polygon 

appears in square units (actual units depend on how you have set the 

units/display). 

 

Calculating evaporative losses 

In order to calculate evaporative losses, you'll need to create a new field in the 

attribute table: 

• Start by making certain that there is nothing selected in your map. Go to the 

main menu at the top of the screen, under Selection, and choose Clear 

Selected Features. 

• Make sure also that you have Stopped Editing. 

• Open the attribute table for the area layer that you created above. In order to 

add a new field where you will calculate evaporative losses, click Option in the 

attribute table window, and select Add Field. Name the field EVAP.  

• Select Double from the Type menu, and type 15 into Precision and 0 into Scale. 

This will allow up to 15 digits in this field (precision) with no digits to the right of 

the decimal point (scale). Because of the huge uncertainties in what we're doing, 

we certainly don't need anything to the right of the decimal point….Click OK. 

• Go to the Editor, and Start Editing. Select your area shapefile. Note: if you 

Start Editing first, and then try to add a field to the attribute table, it won't 

work. If this happens, Stop editing, add the field, and then start editing again. 

• Right click the header in the evaporation field (the word EVAP). Select Field 

Calculator. 

• Double click on F_AREA in the Fields list. It will be automatically added to the 

formula box. If you blunder, just select what's in the box, delete it, and start 

over again. Use the formula-builder to add the rest of the formula, typing in any 

constants you need. Click OK. 

• Save Edits, and Stop Editing. Your new field will show the calculated 

evaporation losses in whatever units you've used for your Units/Display. 

 

Measuring volumes 

ArcMap can calculate the volume above or below a particular elevation on a DEM. 

Unless you mask a smaller portion of the DEM by the instructions below, this operation 

will calculate for the entire coverage of the DEM.  

 

If you need to extract elevation pixels from the DEM for a particular area: 

 

• You'll need a shapefile for the area that you want to extract. If you haven't 

already made  one, follow the instructions above under calculating area. 
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• Make certain that there is nothing selected in your map by going to the main 

menu at the top of the screen, under Selection, and choosing Clear Selected 

Features. 

• Make sure also that you have Stopped Editing. 

• Go to ArcToolbox, Spatial Analyst Tools, Extraction, and Extract by Mask. 

This operation will use your shapefile outline as a "mask" and instruct ArcMap 

to get only those pixels of the DEM covered by the mask and extract them into a 

new layer. 

• Under Input Raster, choose your original DEM (that's where you want to get 

your elevations from).  

• Under Feature Mask Data, choose your new shapefile. 

• Name your Output raster something like maskXX (with XX being the elevation 

of your shapefile), and save it to your folder. Click OK. 

• Now, turn off all of your layers except your new extracted layer, and you'll see 

that your new layer consists only of the pixels in the DEM that are contained 

within the area of the shapefile that you drew. 

 

To calculate the volume above these extracted pixels, we'll ask ArcMap to figure out the 

volume between the elevation of your shapefile level and the DEM. 

 

• Go to 3D Analyst, Surface Analysis, and select Area and Volume. 

• Navigate to you new mask raster (not the original DEM!) for the input surface, 

set the height of the plane at your shapefile level (e.g., 137.00, or whatever it is). 

• If the DEM lies below the shapefile level (e.g., a valley or basin), click the button 

Calculate statistics below plane. If the DEM lies above the shapefile level (e.g., 

a mountain), click the button Calculate statistics above plane. 

• Click calculate statistics.  

• ArcMap presents the stats for 2D area, 3D area (as a curved surface), and 

volume in whatever units you have specified in Units/Display. 
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Downloading Regional Earthquake Data and  
Portraying it in ArcMap and in 3D in ArcScene 

 
Downloading the Data 
Go to the USGS earthquake site at http://earthquake.usgs.gov/ 

 
From the Earthquake Center page above, select Scientific Data, and Scientific Data 

again on the Research and Monitoring page. Choose Earthquake Catalog Search. Then 

choose Rectangular area.  

 

Set the search parameters for:  

 

• Spreadsheet format 

• USGS/NEIC 1973-Present 

• Choose latitude and longitude range values, year range, and magnitude range. 

Notice that SOUTH latitudes and WEST longitudes are entered with a 

negative sign before the degrees. 

 

Click Search and wait for the data. Click and drag to select all of the records, and Copy.  

 

• Open Excel, and Paste everything into the first cell.  

• Go to Data, Text to columns, and. Select Delimited in the first dialog box, and 

Comma in the second dialog box. Click finish.  

• Select the latitude, longitude, magnitude, and depth columns (be sure to select 

the WHOLE COLUMN for each, not just the top cells). Choose Format from the 

main menu,  Cells, and Number. Set the decimal places to 4, and OK.  

• ***Critical step!!! Before you save the file, click once in cell A1. Then, select 

Save As, and scroll down to the format DBF4. Give your .dbf file a SHORT 

name, no spaces, and click OK, and Yes. 

• ****Another critical step!!! YOU MUST CLOSE EXCEL BEFORE YOU CAN 

ADD THE DATA TO ARCMAP!!!*** 

 

The Data in ArcMap 
You’ll need to add a base map to ArcMap so that you can see where your earthquakes 

plot geographically. The following instructions are based on using a world map of 

continents that is included in the 5 DVD set from ESRI called ArcGIS 9 Data and Maps 

Media Kit. The continents map used here is on the Data and Maps and US Street Maps 

DVD. It is located in the World folder, Data folder, continents.sdc. This file can be added 

directly to ArcMap. If you want a .shp file, simply Export Data as a shapefile. If you use 

a different base map, the Coordinate System may not be the same as in the instructions 

here, and you’ll probably also have to play with the scaling factor for depth in ArcScene. 
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Start a new ArcMap, and add continents.shp plus your .dbf file (you can find the 

continents.shp file in the GIS folder on the Academic Software Server).  Be sure that 

Excel is closed; don’t just minimize the window.  

 

• You need to do one thing before your data will show up. If you look at the tabs at 

the bottom of the TOC in ArcMap, you’ll see that the TOC has switched from 

Display to Source mode. Right click on the .dbf file, and select Display XY data. 

Be sure that the X Field pulldown says Longitude, and the Y Field pulldown 

says Latitude. If it doesn’t, select the correct ones from the pulldowns. 

• The Coordinate System of Input Coordinates will say Unknown Coordinate 

System. You need to define a coordinate system for your data so that it will plot 

properly on the map of the continents. Click Edit, Select, and select 

Geographic  Coordinate Systems, World, WGS 1984.prj (the last option). Click 

OK. Now, the coordinate system should read Geographic Coordinate System 

Name: GCS_WGS_1984 

• Click OK. 

 

Now your earthquakes should show up on the map. But you won’t be able to do 

anything with them in ArcScene quite yet. You need to first convert this Events layer to 

a shape (.shp) file. 

 

• Right click on the events layer, and select Data, Export Data. All of the defaults 

are OK. Click on the folder icon, and navigate to where you want to save your 

new shape file, and give it a name. Remember: SHORT, no spaces. Click OK. If 

this fails to execute, check to see if Excel is open. Excel must be closed (not 

just the windows minimized) in order for this to work. 

• You can now delete your original events layer and return to the Display view 

(click the Display tab at the bottom of the TOC). 

 

Open the attribute table for your new shape file (right click on the name in the TOC, 

and select Open attribute table. All your data will be there. Close the attribute table. 

 

In map view, select the Information tool (the “i”), and you can click on any earthquake 

on the map and find out information about it. It’s all the information in the attribute 

table that allows you to display the data by various attributes. 

 
• To change the symbols: 

o Go to Properties for your earthquakes layer, and select Quantities. 

Choose either graduated colors or graduated symbols In the value field, 

choose DEPTH. Choose the number of classes you want, and select a 

color ramp. Click OK. 

o Add the earthquakes layer again several times, and color-code different 

properties on each layer. 
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To view your quakes in 3D in ArcScene 

The following instructions are tailored for the ESRI continents.shp map base added in 

the previous instructions. If you use a different map base, you’ll need to fiddle with the 

conversion factor. 

• Open to ArcScene. Add the continents layer and the earthquakes layer. 

• Go to the Properties for the earthquake layer, and select the Base Heights tab. 

Click the icon to the right of the box under Height. This is the "Expression 

Builder". Double click on DEPTH then single click on * (multiply) and single click 

on –  (minus) then .005, so that your expression looks like: 

 

[DEPTH]*-.005 

 

• This will tell ArcScene to take the values in the earthquake depth column and 

multiply them by a factor to place them at the correct depth in the scene 

(because the map coordinates are not in kilometers, we need this conversion 

factor). This conversion factor is pretty good and doesn’t exaggerate the vertical. 

If you want to exaggerate the vertical, change the conversion to -.01, but realize 

that this will exaggerate the dip of a Benioff Zone. 

• You can also go to the Symbology page and code the quakes by color or symbol, 

and you can make the continents layer partially transparent so that you can see 

the earthquakes better as you rotate the scene. 
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Downloading Orthoquads from the NYS GIS Clearinghouse 
 

Downloading the data 
Although you can access these and other GIS data sites on a Mac, some of them do not 

work well, if at all, when using Mac based Internet browsers. So, do all your data 

acquisition on a PC with a stable Windows based-browser such as Internet Explorer. 

 

• Go to the New York State GIS Clearinghouse site at www.nysgis.state.ny.us/ 

 

This is a gateway to an enormous set of GIS data for New York State. Most states now 

have web-accessible GIS clearinghouses of some sort, and a Google search will bring up 

URLs for them. Data may be free to download, have a charge associated with the 

download, or be restricted to some users. The NY State GIS clearinghouse has all three 

types of data. As members of the GIS Data Sharing Cooperative, Hamilton College 

faculty and students can access restricted data on this site, but a specific user ID and 

password are required to retrieve restricted data sets. Fortunately, the data you will be 

downloading are not restricted and do not require a password. 

 

• On the main page of the NYSGIS Clearinghouse site, click GIS DATA in the top 

blue bar. This window shows the types of data sets available.  

• Under Imagery Data Sets, click Raster Imagery. This opens a window listing 

the types of maps available.  

• Under the heading 1:24000 NYS DOT and USGS, click View By Quad Map. A 

map of New York overlain by an index of USGS 7.5 minute quads opens. The 

names of individual quads are not shown, but if you place the cursor over a 

rectangle, the name and DOT code for the map appears. You can also display a 

list of the quads, arranged by name, NYS code, or USGS code by clicking on the 

appropriate links at the top of the map page.  

 

Maps downloaded directly from the NYSGIS clearinghouse site are collared, meaning 

that all of the information in the border around the printed map is included (e.g., scale, 

lat/lon, titles, magnetic declination, etc.). When you're using individual maps (as we are 

in this exercise), having the collared maps is fine. So, you'll download your map from 

this site. Other sites have quads with the collars removed, which is convenient for 

mosaicking. We'll learn how to do that some other time. 

 

• On the View By Quad Map page, find the quad you want. Quad names appear if 

you rest the cursor over an individual quad.  

• Once you locate your quad, click on the quad to open its main page. This page 

lists the available files associated with the quad. Two types of map data are 

listed, a 7.5 minute Department of Transportation (DOT) map and a 7.5 minute 

USGS topographic quadrangle map.  
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o The DOT map consists of two layers, one with just roads and one with 

just streams. All hydrologic features and urban area tinting are removed 

from these maps. This is not the one we want. 

o The USGS quad is exactly that, a scan of the printed USGS 7.5 minute 

topographic quadrangle map. It isn't just a simple scan, though. The 

data include an associated file (a World File with a .tfw suffix) that 

allows ArcGIS to display it in the proper global space when it is brought 

into ArcMap.  

 

• We want to download the USGS DRG topographic quadrangle. This is likely not 

the first listing on the page, so be sure that you look carefully to find the 

correct download hot link. You can use Preview to make sure that you have the 

correct map. Under the header USGS Digital Raster Graphic Quadrangle, find 

download quad, and click the link. When prompted to save, navigate to your 

XXX_doq folder, and save. This is a zipped file and won't appear in ArcCatalog 

yet. We will unzip it after we have downloaded the rest of the data we want. 

 

• At the bottom of the page where you clicked the download link, you'll see 

Additional Coverages, which provides a direct link to your quad’s data at the 

CUGIR site (Cornell's Geospatial Information Repository). Click this link. If this 

link is not working, you can go directly to the CUGIR site at 

http://cugir.mannlib.cornell.edu/. A listing of the data sets available for your 

quad at the CUGIR site comes up. It lists three data sets: 7.5 minute 

topographic maps, elevation (DEM data), and hydrography. If you want 

instructions on how to download and decompress DEM data from CUGIR, go to 

that section in this primer.  

 

To decompress the DOQ 
• To decompress the topo map in your XXX_doq folder: 

o In Windows Explorer (not ArcCatalog) navigate to your XXX_doq folder 

on the C:/ drive. 

o Right click on the zipped folder and scroll down to Extract All. 

o Extraction Wizard opens, click Next, and the Wizard creates a default 

folder to extract the files to. This folder will have the same name as the 

original folder without the .zip extension and will automatically be placed 

into your XXX_doq folder.  

o Click Next, and the extraction progress bar appears, and the files are 

extracted.  

o When the extraction is done, click Finish. The default when clicking 

Finish is to show the decompressed folder, which looks exactly like the 

original one without the zipper. Double click this folder to open it. The 

data downloaded from NYSGIS will appear as three files, your topo quad 

with a .tif extension and two additional files of metadata.  
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• Once you have all of your data sets, you can do some housekeeping in 

ArcCatalog to make the finished data more accessible. The topo quad should be 

at the top level of its respective folder XXX.doq). Use ArcCatalog to move it to 

that level. You can also use ArcCatalog to change the name of the topo quad to a 

meaningful name, rather than a number.  

 

• Once you've used ArcCatalog to move your finished topo quad, you can then use 

ArcCatalog to delete all of the original downloads, although it doesn't hurt to 

keep them until you make sure that your files are working correctly so that you 

don't have to go back and download everything again. If you're working on an 

important project, it's a good idea to back up the original data folders or burn 

CD/DVDs of the data before deleting the original folders. 
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Working with Digital Orthoquads, 
Orthophotos, and Geologic Maps 

 

DEMs (Digital Elevation Models) do not have geographic or cultural information, and, 

unless you are really familiar with an area, you may not recognize individual 

geographic features just by looking at the DEM. We can combine a DEM with other 

kinds of data such as satellite images, air photos, or map data (e.g., a digital 

orthoquad, which is a digital version of the standard USGS topographic map) to create 

a composite map with different layers contributing various components to the final 

map. The composite map, with variably transparent layers, will let us locate geographic 

features while still being able to visualize the 3D shape of the land surface.  

 

Combining the DEM with a quadrangle map is made possible because the data files 

are georeferenced. In other words, there is information in the files (the metadata) that 

tell ArcMap exactly where in the world the map is, what its scale is, what the units of 

measure are, and what technique was used to project that portion of the Earth's 

sphere to a flat map surface. If any of these pieces is missing (or if the projection 

method of the DEM doesn't match the projection method of the orthquad), you may 

have difficulty combining the maps successfully, although ArcMap will try to project a 

new data layer on the fly. This is not a trivial issue. 

 

Projections 
• If you want to combine several types of data in one map, all files must have a 

coordinate system and projection.  

• ArcGIS will attempt to project "on the fly", fitting the files to the current 

coordinate system and projection of the map. If a file doesn’t have a coordinate 

system, you will get a dialog box saying that the layer can be drawn, but not 

projected, and ArcGIS will guess what the projection of the file is, although this 

may mean that features drawn on the map are not accurately located. 

• You should be able to find out what the coordinate system and projection of the 

data is by checking the files spatial metadata in ArcCatalog. Unfortunately 

some data sets, such as shape files, may not have metadata tied to them, 

depending on how careful the creator of the file was to document the metadata.  

 
Superimposed topo features on a DEM hillshade 
Add the orthoquad and the DEM as data layers, and make a hillshade from the DEM 

layer. You'll  now see the hillshade layer in the TOC. Rename it, if you like. You can 

use one of two techniques to combine a topo map and a hillshade: 

• Putting the hillshade on top and making it partially transparent: 

o Order the layers so that hillshade is above the topo layer. 
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o Go to the Hillshade layer Properties, and change the Display options to 

make the hillshade partially transparent. Increasing contrast and 

brightness of the hillshade can help improve appearance. 

Putting the topo map on top, and deleting unwanted colors 

o Re-order the layers in the TOC so that the orthoquad is the top layer. 

o An orthoquad is raster image, and ArcMap knows what color every pixel 

is in the file. We can selectively replace pixels of a particular color with a 

new color or with no color, in order to make the pixel transparent. 

o Making the white background of the map disappear. Zoom out using 

the globe tool. Expand the orthoquad layer by clicking on the plus sign 

next to the layer name. Right click in color box #1, and select No color. 

Zoom in, and admire how you can now see a whole lot of the hillshade 

below. But, there are still some patches we'd like to get rid of, while still 

keeping some of the geographic features on the map. 

o Do the same for color boxes 5, 6, 7, 9, 10, and 11. Don't do 4, 8, and 

12!!! This will turn off all of the aspects of the map that are colored any 

other color except brown (topo lines), red (roads), blue (water), and black 

(labels, buildings, etc.). Use the magnifier tool (you can dock the floating 

tool bar, if you want) to browse around and check to see whether the 

streams lie in the bottoms of the valleys on the DEM. 

o If you reassign a color to an item and want to reconstruct the colors, 

here are the standard USGS colors that you can use to get back to 

exactly the original colors. In the TOC, double-click on the color square, 

click on the Color tab, and type in the following numbers: 

 

USGS Digital Raster Graphic Color Palette 

            -------------------------------------------------------------------- 

            Digital Number    Color          Red        Green       Blue 

            --------------------------------------------------------------------                                                             

 0 Black 0 0 0 

 1 White 255 255 255  

 2 Blue 0 151 164  

 3 Red 203 0 23 

 4 Brown 131 66 37 

 5 Green 201 234 157  

 6 Purple 137 51 128  

 7 Yellow 255 234 0 

 8 Light Blue 167 226 226  

 9 Light Red 255 184 184  

 10 Light Purple 218 179 214  

 11 Light Grey 209 209 209 

 12 Light Brown 207 164 142 
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Proving to yourself that the orthoquad is in the right place 
Did ArcMap put the digital orthoquad in the right place geographically? You can easily 

check this. Zoom in on the lower right hand corner of the image until you can read the 

lat/lon coordinates on the digital orthoquad. Position the cursor so that it lies right at the 

corner of the quad, and check to see if the lat/lon value for the cursor (shown in the 

information box at lower right) matches the values printed on the map. They should!! 

 

Checking orthophotos for proper placement 
 

If an orthophoto file has correct metadata (coordinate system and projection), ArcGIS 

will “project on the fly” and place the orthophoto in the correct geographical position on 

the existing map, regardless of the coordinate system and projection being used on the 

map. 

 

ArcGIS is almost magical in how it handles data in various projections and coordinate 

systems, so much so that you may not pay as close attention as you should when it 

displays data.  

• Always look at data once they is added to the map. Do they make sense? Do 

features line up with features on other layers? If not, is there a consistency to 

how they are not lining up?  The same feature  mapped in NAD 27 and NAD 83 

coordinate systems and overlaid on top of each other can be offset approx 100 m 

(in our area this tends to be to the NW). If you see this kind of offset, be thinking 

it is a Datum problem. 

• When checking placement of orthophotos by comparing features on the photos 

to those on, say, a topo map, be careful what features you use to compare. 

Orthophotos are recent (typically within the past few years), whereas topos have 

been around for quite a while. For example, the local Rome quad was last 

revised in 1955. Roads, buildings, and even streams may have changed 

significantly over the time between the map and the orthophoto. Check a 

number of features before deciding that something does not line up. 
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Adding GPS waypoint data to an ArcMap 
 
We can download the GPS data directly from the Garmin unit to a shapefile that can be 

added a map. 

 

Downloading the data from the Garmin unit 
• Make sure that you don’t have a "low battery" message on the Garmin unit. If 

you do, replace the batteries. You don't want to run out of power while you're 

transferring data. 

• Plug the cable into the Garmin unit and into the computer. 

• On the computer, launch DNR Garmin. In the window that comes up, make 

sure that it says Connected in the lower left corner.  

• Click the GPS tab, and check to make sure that Set Port is set to Port 1 and 

that Set Baud Rate is set to  9600. 

• Due to a bug in DNR Garmin, use the following procedure to set the projection 

before downloading waypoints 

 File> Set Projection 

o Choose a projection you will not use, e.g., NAD 27 UTM 14 N. Set this, 

and click OK. 

o Reopen the window File> Set Projection, set the correct projection NAD 

27 UTM 18 N, and click the Load PRJ button. 

o Navigate to correct projection, Projected Coordinate Systems > UTM > 

NAD27> NAD27UTM18N, and click open. 

o You’ll be returned to the DNR Garmin dialog box. Click OK. 

o The projection window on main screen should show NAD 27 UTM 18 N 

• Click the DataTable bar, which brings up a data table screen. 

• Click the Waypoint tab in the main menu bar (not the radio button in the data 

table), and select Download. Woo woo! There are your waypoints! 

• Click on the File tab in the main menu, and select Save To and File. Navigate 

to your data file, name the file (remember! short! no spaces!!). Scroll down to 

ArcView Shapefile Projected in the Save as type box. Click Save. Check in 

ArcCatalog under the Spatial tab to make sure that the projection is 

attached. 

 

Adding your GPS waypoints to your map 
• Open ArcCatalog, and check to make sure that you know where your waypoints 

shape file is. 

• Launch ArcMap, and open your ArcMap. 

• Add the waypoints shape file (using the Add Data button). All of your waypoints 

should plot instantly!! Much easier than plotting by hand!! Zoom in and look 
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around to see if ArcMap has plotted your stations where you think they ought to 

be. 

 
Opening an Attribute Table 

• Let’s look at the data behind the Waypoints layer. 

• Right click on the waypoints layer in the ArcMap TOC, and select Open 

Attribute Table.  

o Each column is called a Field. Locate the field with your station names 

in it, and notice that the name of this field is IDENT. This is important to  

know, because you'll want to label your waypoints on your map, and 

you'll need to know the name of the field that contains the station 

names. 

o LAT and LON fields: these fields contain the lat/lon data from the 

Garmin unit in decimal degrees (rather than in degrees, minutes, and 

seconds). 

o Y_PROJ and X_PROJ fields: these are the fields that ArcMap uses to put 

the waypoints in the proper place. When you set up DNR Garmin, you 

selected a datum and a projection. That choice allowed DNR Garmin to 

decide what to do with the lat/lon data to convert it to a number that 

ArcMap can plot and plot correctly. If you had inadvertently chosen a 

datum and projection that didn't match the one for your ArcMap file, the 

waypoints would not plot in the correct place on the map. 

o Close the Attribute Table. 

• As you did with the towns, add labels to your waypoints so that they're not just 

symbols (Properties, Labels, Label features in this layer, and, in the Label field, 

be sure to select the field name for your stations). You can also change the 

station symbol style, size, and color (left click on the symbol itself in the TOC). 
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Creating a Map Layout 
 

Viewing the layout 

• Below the regular ArcMap window, you will see two icons, a globe icon and a 

page icon. The globe icon takes you to the regular global view where you add and 

modify layers in ArcMap. The page icon takes you to the Layout view. 

• Toggle back and forth to see the difference. 

• In Layout view, clicking on your map will bring up a Data Frame. The colored 

outline and boxes of the Data Frame must be visible any time you want to 

modify the Data Frame. 

 

Selecting what will appear in Layout View 

• Whatever appears in the ArcMap window will be what you'll see in Layout view.  

• Zoom to the portion of the file that you want to show, or zoom all the way out to 

include the entire file in the view. 

 

Moving around in the layout view 

• If you use the regular zoom and pan tools in the layout view, you will 

change what appears in the Data Frame. Remember that only what appears in 

the data frame will print. If you accidentally do something you regret, click 

the big blue left arrow to return to the previous extent. 

• If you want to zoom your layout view without changing what's in the Data 

Frame, you have to uses the layout Zoom and Pan tools in the layout menu bar 

(the ones with the little page icon under the Zoom and Pan icons). 

 

Setting the Page Set-up for your Layout View 

• Go to the File menu and select Page and Print Set-up. 

• In this dialog box, you can select a printer, page orientation (landscape or 

portrait), and paper size. Be sure to check the box labeled Scale Map 

elements proportionally to changes in Page Size (this is at the bottom of the 

dialog box). Select the paper size you want. And be sure to also click Use 

Printer Page Settings in the Map Page Size. 

• Click OK. 

 

Changing the size and position of your Data Frame 

• Be sure that your data frame is selected. Clicking and dragging will move the 

data frame. 

• Clicking and dragging a side handle will make the data frame shorter/taller or 

wider/skinnier (e.g., if you want to bring the border closer to the object inside 

the frame). 
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• Clicking and dragging a corner handle will scale both height and width of the 

frame and what is in the frame.  

 

Adding scale, north arrow, etc. to your Data Frame 

Any of the items that you add below can be removed by selecting them a hitting the 

delete key. Start by selecting the data frame in the layout view using the selection 

tool (black arrow) in the main toolbar. 

• Adding a neat line 

o From the Insert menu, select Neatline. Choose the kind of border you 

want, and click OK. 

 

• If you don't want to have either a neat line or a frame around the object. 

o Even if you don't add a neat line, the default setting will put a black 

frame around the data frame. If you don't want this, right click on Layers 

in the TOC, and select Frame. Under Border, scroll up to None. Click 

OK.  

 

• Adding a north arrow 

o From the Insert menu, select North arrow. Choose the kind of north 

arrow you want, and click OK. 

o The north arrow appears in your Data Frame. To move it around, click 

on it to highlight it, and move it or scale it by dragging the handles. 

o To modify your north arrow, double-click on it, and choose a new color or 

a new style. 

 

• Adding a title 

o From the Insert menu, select Title.  

o The easiest way to add and modify a title is to click anywhere outside the 

title to deselect it, and then double-click on it to bring up the properties 

box.  

o Type your title into the text box. 

o To select fonts, sizes, and colors, go to the bottom of the main screen to 

make selections.. Clicking apply instead of OK lets you test out options. 

o When you're happy with what you have, click OK.   

o To move the title around, click on it to highlight it, and move it where 

you want it to be. 
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• Adding a scale bar 

o Go to the Layer Properties, and select the General tab. Choose the 

display units that you want. Choose something practical, because this is 

what will appear on your scale bar. 

o From the Insert menu, select scale bar. Choose the kind of scale bar you 

want, and click OK. 

o The scale bar appears in your Data Frame. To move it around, click on it 

to highlight it, and move it or scale it by dragging the handles. 

o To modify your scale bar, double-click on it, and make new choices. 

 

• Adding a callout box 

o In the drawing menu, click on the down arrow next to the Text tool (the 

A). Select the callout box (looks like a cartoon caption). Click on the map 

layout and drag. Type your text into the textbox, and format it using the 

text formatting tools in the Drawing toolbar. 

o Hit Enter. 

o To move the end point, select the callout box, and click and drag the end 

point. Ditto for the box. 

o If you want to change the text in the box, double click on the text in the 

box, and enter the text in the dialog box. 

 

• Adding a text box (this kind of a box won't have a leader) 

o From the Insert menu, select Text. Again, it's easiest to click outside to 

deselect it and then double click to bring up the options box.  

o Text does not wrap in this option. You will have to add returns where 

you want them. 

o Type what you want in the text box, and use the bar at the bottom of the 

main window to make choices about text font, size, and color. Click OK. 

o The text appears in your Data Frame. To move it around, click on it to 

highlight it, and move it or scale it by dragging the handles. 

o To modify your text, double-click on it, and make new choices. 

 

• Adding a leader or a line with an arrow 

o Find the Drawing icons at the bottom of the main window. Click on the 

line icon, and select the line tool. 

o Draw your line, and double-click to end the line. Double-click on the line 

to bring up the properties box, and, if you want an arrow, go to Change 

Symbol and scroll to the bottom. Click OK. 
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• Adding the Hamilton GIS logo 

o If you want to add the Hamilton GIS logo to your map, from the Insert 

menu, select Insert Picture. Navigate to the main level of the 

Geosc103_Data folder, and find geoGIS.tif. Select it. 

o It's big, and you can modify its size by click on it and dragging the 

handles. 

 

Map with multiple windows (Data Frames) 
You can make a map with multiple windows that show zoomed-in portions of your main 

map, and you can even link the windows together!! Very fancy. Save often as you are 

doing this!! It's easy to do something that you will regret. 

 

Creating the base map 

• Zoom in to whatever you want to have on your main base map. 

• Switch to layout view. 

• Add scale bar, north arrow, neat line, title, key, whatever you want. 

 

Adding new windows (Data Frames) 

• The new windows are called Data Frames.  

• If you want to have a second data frame, go to the Insert menu, and select Data 

Frame. You'll see a new listing in the TOC, and you'll see that your new Data 

Frame doesn't have anything in it. Go to your TOC, and left click and hold on 

the title of the layer you want to have in the new data frame, and drag it and 

drop it in your new data frame. You can drag as many layers as you want from 

the original menu. If you select the magnifier or pan tools from the regular 

menu (not the layout menu), you can zoom in to what you want in the new data 

frame. Pretty cool!!! 

• Rename your new data frame with a descriptive name. 

 

Linking your new Data Frame to the original window 

• Right click on the original Layers in the TOC, and get the Data Frame 

Properties. Select the Extent Rectangles tab. Click on your original Layers in 

the Other  Data Frames, and click the right arrow to move it to the right hand 

list.  

o Click the Frame button, and choose the color and size of the framing 

rectangle. You can always change this if you don't like it. You can see 

what it looks like by clicking Apply before you OK everything.  

o To connect your new frame to the extent rectangle with a leader, check 

the Show Leader box, and choose Leader Symbols. When you're happy, 



 

version of 12-10-09 Barbara Tewksbury, Hamilton College (btewksbu@hamilton.edu) page 59 

click OK. You should now have a rectangle on your original map window 

that is connect to  your new data frame. 

o If you move your new data frame, just click the refresh icon (next to the 

page layout icon), and the leader will re-draw. 

o If you don't like the frame or leader, just go back to the Properties again 

and change them. 

• If you use the regular zoom and pan tools (not the ones for the layout view), 

you'll see that the rectangle changes size and location as you pan and zoom. 

Extra cool!!! 

• You can add separate titles and neat lines for your new data frame. 

• You can add as many new data frames as you want and link them to the original 

window. Just remember that you need to go to Layer Properties for the original 

Layers to make the extent rectangle show up on the original window. If you add 

several, you'll see why it's so important to rename each one! 

 

Exporting your map 

o When you are happy with your map, go to the File menu, and select Export 

Map. Under Option, click the General tab, and set the resolution to 200. 

o You can select either jpeg format or pdf. For best printing, select pdf format. 

Then, click the Format tab, and click in the box to Embed all document fonts. 

o Name your map file. Navigate to your own data folder, and click Save. 
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Printing and exporting from ArcMap  
 

If you want to do a map layout, with title, scale bar, etc., follow the instructions in 

the previous section. If you just want to print or export a portion of your ArcMap, 

follow these instructions. 

 
Printing from ArcMap 

• Start by turning off the layers you don't want to have on your printout. 

ArcMap will print only the layers that are visible (i.e., that have check marks 

next to the layer names) 

• Then, in Map View (not Layout View)zoom in or out to what you want to have 

on the printed page. ArcMap will print whatever shows in the map window.  
• From the main File menu, select Page and Print Set-up. Make sure that the 

paper size is set to the size you want, and choose either Portrait or 

Landscape. Be sure that the box Scale Map Elements… at the bottom is 

checked.  

Click OK.  
• Under File, you can Preview the page, if you want. 
• When you are ready to print, select Print from either the Preview window or 

from the main File menu. 
• If you want to print in color, export your map as a jpeg or pdf (under the 

main File menu), and add insert it into a Word file or open it in Acrobat 

Reader. 
 

Exporting from ArcMap 
• Start by turning off the layers you don't want to have on your export. 

ArcMap will export only the layers that are visible (i.e., that have check 

marks next to the layer names). 

• From the main File menu, select Page and Print Set-up. Make sure that the 

paper size is set to the size you want, and choose either Portrait or 

Landscape. Be sure that the box Scale Map Elements… at the bottom is 

checked. Click OK. 

• Then, in Global View, not Layout View, zoom in or out to what you want to 

have on your export. ArcMap will export whatever shows in the map window.  
• When you are happy with your map, go to the File menu, and select Export 

Map. Under Option, click the General tab, and set the resolution to 200. 

• You can select either jpeg format or pdf. For best printing, select pdf format. 

Then, click the Format tab, and click in the box to Embed all document 

fonts. 

• Name your map file. Navigate to your own data folder, and click Save.  
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